Newage Testing Instruments, Inc. reserves the right to alter designs, materials, and specifications when conditions warrant, without notice.

Newage Testing Instruments, Inc. makes no representations or warranties, either expressed or implied, with respect to this publication and accompanying software and specifically disclaims any implied warranties of merchantability or fitness for any particular purpose. This publication and accompanying software are sold "as is", and Newage Testing Instruments, Inc. will in no event be liable for direct, indirect, incidental, or consequential damages resulting from any defect, error, or failure to perform.

The software described in this publication is furnished under license and may only be used in accordance with the terms of such license.

C.A.M.S.™ is a trademark of Newage Testing Instruments, Inc. Windows® is a registered trademark of Microsoft Corporation.
## CONTENTS

### SECTION 1: INSTALLATION ................................................................. 7
1.1 Introduction .............................................................................. 7
1.2 Basic System Layout ............................................................... 7
1.3 Initial Setup ............................................................................ 8
   1.3.1 Machine Installation ..................................................... 8
   1.3.2 Cable Connections ....................................................... 9
1.4 Software/Camera Installation .................................................. 12
   1.4.1 Initial Software Startup .............................................. 12
1.5 X/Y Tables Setup ..................................................................... 12
1.6 Do’s & Don’ts .......................................................................... 13

### SECTION 2: FILE SETUP .................................................................. 14
2.1 Create a New File ..................................................................... 14
2.2 Open an Existing File ............................................................. 19
2.3 Close an Open File ................................................................. 19

### SECTION 3: SINGLE POINT TESTING AND MAIN SCREEN FUNCTIONS ......... 20
3.1 Single Point Testing ............................................................... 20
3.2 Test Result and Tolerance Display .......................................... 20
   3.2.1 Prompt the Comments Screen for Out-of-Tolerance Results 20
3.3 Clear Last Button ................................................................. 21
3.4 Reports Button ....................................................................... 21
3.5 Status Bar ............................................................................... 21
3.6 Test Parameters ....................................................................... 21
3.7 Update Test Parameters ........................................................ 21
   3.7.1 Update: Changing the Load ......................................... 21
   3.7.2 Update: Color, Width .................................................. 21
   3.7.3 Update: Changing the Table Offset ......................... 22
   3.7.4 Update: Calibrate button .......................................... 22
   3.7.5 Update: Changing the unit of measurement .............. 22
   3.7.6 Update: Camera ........................................................ 23
3.8 Image Magnification and Screen Capture (Save) ....................... 23
3.9 Full Button .............................................................................. 23
3.10 Basic Motorized X/Y Table Operations ................................... 24
3.11 Traverse Button .................................................................... 25
3.12 Space Bar (on keyboard) ....................................................... 25
3.13 Indenter Height Adjustment .................................................... 25

### SECTION 4: MAIN MENU BAR FUNCTIONS ........................................ 26
4.1 Main Menu Bar: View ............................................................ 26
   4.1.1 Reports (Advanced Statistics Software) ..................... 26
4.2 Setup Menu ............................................................................. 27
   4.2.1 Average Menu (Appears when averaging option is enabled) 27
   4.2.2 Test Setup .................................................................. 28
   4.2.3 Tolerances .................................................................. 28
   4.2.4 Scale Setup ................................................................ 29
   4.2.5 Communications Setup ............................................. 29
   4.2.6 Settings ..................................................................... 29
4.3 Main Menu Bar: Data ............................................................. 30
   4.3.1 Clear Last Test .......................................................... 30
   4.3.2 Clear Test Number ..................................................... 30
   4.3.3 Clear All Tests .......................................................... 30
   4.3.4 Statistics .................................................................... 31
   4.3.5 Part Information ........................................................ 31
SECTION 5: TRAVERSE OPERATIONS
   5.1 Create Traverse ................................................................. 32
   5.2 Edit Traverse ........................................................................ 37
   5.3 Run Traverse ........................................................................ 38
   5.4 Traverse Reports ................................................................. 41
       5.4.1 Standard Reports (See following pages) ......................... 41
       5.4.2 Multiple Reports (See following pages) ......................... 41
   5.5 Traverse File Menu (Maintenance) ....................................... 44

SECTION 6: MACHINE CALIBRATION CHECKING ................................. 45

SECTION 7: TROUBLESHOOTING GUIDE ........................................... 46

SECTION 8: MAINTENANCE, SERVICE & REPAIRS .............................. 48
   8.1 Maintenance .......................................................................... 48
   8.2 Service .................................................................................. 48
   8.3 Moving the Tester ................................................................. 48
   8.4 Packing the unit for shipment ............................................... 49

APPENDIX A1: SPECIFICATIONS ....................................................... 50
APPENDIX W: ONE YEAR LIMITED WARRANTY ................................. 51
SECTION 1: INSTALLATION

1.1 Introduction

Welcome to the Newage Testing Instruments, Inc. MT-91ASW, Automatic Microhardness Testing System. The Newage MT-91 Microhardness Testers use a Rockwell technique to measures the depth of indentation using low loads (500g to 5000g). The indenter is a truncated cone shape.

All testing routines are controlled by a computer. The program that the tester follows is designed to guide operators through the basic testing routines. It provides prompts and menus so that the operator needs to have only a basic knowledge to perform set-up and test functions.

This manual is written to take the operator step by step through the program, with examples of the screens, menus and dialog boxes that appear on the display.

NOTE: Some pages in this manual may show screens and printouts which may differ slightly from your system depending on the options purchased.

1.2 Basic System Layout
1.3 Initial Setup

1.3.1 Machine Installation

1. The MT-91ASW system must be installed on a desktop or table area of at least 48” wide x 24” deep x 28” high, including the area for the printer, if it is arranged as seen above with the computer resting on the motorized table controller.
1.3.2 Cable Connections  (See next page for diagram)

1) Attach all power cords to the plug strip(s) and wiring between components according to the following description. Turn on power to motor controller. **DO NOT TURN ON MAIN POWER SWITCH.**

Connections to Central Processing Unit of Computer
- Keyboard
- Mouse
- Power supply cord - AC
- Monitor
- Printer
- USB Camera
- Motor Control Unit (USB)
- VDT to USB
- Illuminator
1 • POWER
2 • MOTOR STATUS LIGHT 1
3 • MOTOR STATUS LIGHT 2
4 • MOTOR STATUS LIGHT 3 (not used)
5 • STOP
6 • POWER CORD
7 • COM 2 (TO COMPUTER)
8 • MOTOR CONNECTOR 3 (not used)
9 • MOTOR CONNECTOR 2
10 • MOTOR CONNECTOR 1
11 • FAN
12 • KEYBOARD

Connections to Motor Control Unit (Above)
- Power brick
- USB to computer
- 25 pin connector from x/y motors & switches
- 25 pin connector from test head
2) Connect power cord to the PC and motor controller.  
   Turn on main power switch.  
   Turn on PC and motor controller.

3) Place a test block into the mount.

4) Begin the program operation by selecting the MT91 CAMS operation from the Windows desktop. Using the mouse select the EXIT TRAVERSE button from the lower left of the screen.

Camera and Vise Assemblies

1 • USB CAMERA  
2 • TEST HEAD  
3 • ZOOM ADJUSTMENT  
4 • CAMERA BRACKET  
5 • FOCUS ADJUSTMENT  
6 • TEST STAND COLUMN  
7 • INDETER  
8 • SELF LEVELLING SAMPLE VISE  
9 • LED ILLUMINATION LIGHT
1.4 Software/Camera Installation

The software should already be installed on the computer. Instruction for reinstallation are on software distribution media (thumbdrive or disc).

SECURITY LOCK INSTALLATION

1) USB KEY
If the system has a USB Security Lock (Green Key), the Drivers for the USB KEY are installed as part of the program installation. Insert the Key, Choose the Automatic mode. Windows will display "USB Key found". Before running the Application, run the file Usbkey.reg, found on the CD in the folder KeylockUSB. This will update the registry to search for the lock on the USB Ports. Should the system have difficulties installing the drivers, additional drivers for the key are in the folder KeylockUSB.

NOTE: Plug the Key into ALL USB ports and install drivers at this time. Each USB port needs the driver installed.

2) PARALLEL PORT KEY
If the system has a Parallel Security Lock (Black Dongle), the software for it must be installed; the files are on the floppy disk labeled Keylock or in the folder “Keylockparallel” on the installation CD. Run the setupkey.exe file first, follow the prompts, then when done run the file Everkey.reg, also from the folder “Key” on the installation CD; this will update the registry for the lock on LPT1.

1.4.1 Initial Software Startup

1) Double click the icon to start the program.
2) The program will open up to the last file that was in use. If no data files have been created, the operator can create a new file. (See Sec 3.1 Create a New File) Hardness test results will be added to the database of the current open file.

1.5 X/Y Tables Setup

The motorized X/Y axis tables come pre-installed on the tester.
1.6 Do’s & Dont's

DO:

- Keep printouts of the setup files and file name catalogs handy. This will expedite program operation.

- Backup files periodically so that a minimum amount of data is lost if the hard disk should fail.

- Tighten the specimen in the mount very firmly. Any slight motion of the specimen during testing will adversely affect repeatability.

- Keep the test head level and the indenter and shroud clean.

DO NOT:

- Hit the indenter with any object, at any time. This includes avoiding the sample and mount during table travel from camera to indenter position.

- Test onto the specimen mount clips, off the edge of the specimen, or off the edge of the sample mount.
SECTION 2: FILE SETUP

NOTE: The MT91 software starts up in the Traverse mode. To move to the Manual Test mode select the Exit Traverse button from the lower left of the Traverse Test screen.

The Main Menu Bar at the top of the screen contains 5 selections: File, View, Setup, Data, and Help. They can be accessed with the mouse by clicking on the selection. Click on one of them to open up individual selections. **IF THE MAIN MENU IS GRAYED OUT AND NOT ACTIVE, THE OPERATOR MUST SELECT “EXIT TRAVERSE” FROM THE TRAVERSE BUTTONS AT BOTTOM LEFT.**

The File Menu consists of 7 different functions: New, Open, Close, Print, Print Preview, Print Setup, and Exit, as well as a listing of the last 4 files that have been in use.

### 2.1 Create a New File

1) Select **New** from the File Menu. The **Create a New Test File** dialog box will appear.

2) Type in the name of the file (8 characters maximum) using the **.CSV** extension and select the **OK** button (or press **Enter**).

   ![Create a New Test File Dialog Box]

3) The operator is prompted for what set of parameters to use. The operator can select "Use Current Parameters" to enter the file parameters from the most recently used file and then prompted for a new comment to further identify this file. If the operator selects "Enter New Parameters", a completely new set of parameters can be set up. The final selection is "Retrieve Parameters" (optional - appears grayed out when not activated). When activated a prompt appears to enter the file name from which to retrieve the parameters. Then the operator can enter a new comment for this selection.

   ![Parameters Options Dialog Box]

If the "Enter New Parameters" selection has been chosen, the operator will then be prompted for "Data Part File Information". This information can be used to keep track of Part Number, Description, Order Number, Comments, etc., related to the data file just created. These headings will appear on printouts. Data entry is not required. Select OK when done.
Clicking on the checkbox for "Prompted" will cause this screen to appear after each test so the operator can enter relevant data. This function pertains only to single point testing - not traverses. Selecting "Sort by Prompt" will sort data in the printouts by the prompts so commented data can be readily identified.

The operator may create custom headings by selecting the "Field Names" button, (See graphic below) highlighting the name you wish to change, and typing in the new heading. To make the new headings you’ve typed the default headings for all new files you create, select Change Defaults. "Use Defaults" will revert changed headings to the current default headings. (See graphic below)
4) The next dialog box requires you to "Select a Scale". When using the MT-91ASW for case depth analysis the scale selection must be HRC (Rockwell C). If you would like the test result to be converted and displayed in another test value, highlight one of the Converted Scales listed on the right.

The scale abbreviations which may be listed are:

- HV = Vickers Scale
- HK = Knoop Scale
- HB = Brinell Scale for BOSS
- INCH = Measurement in Inches for linear measurement
- MM = Measurement in Millimeters for linear measurement
- HRC, HRB, HRA, HR15N, etc = Rockwell C, B, A, 15N scale, etc.

NOTE: The scale cannot be changed for a data file that contains test results. The operator will be prompted to change files if he tries to change scales with data in the file.

5) After selecting the scale the operator is prompted to selected the "Average" option. If available, the operator may select to record averages of multiple tests rather than the individual tests (See Section 4.2.1 for more detail) Otherwise the operator may select "OK" to move to the next setup functions.
6) After the averaging screen, the operator is prompted for "Set Tolerances". The program uses these tolerance and warning settings for statistical calculations and for HI, LO, and OK indications for individual test results (but not for the traverse results - which can have tolerances created in "traverse setup" mode). Test results falling within the tolerances are color-coded green on the main single-point-test screen. Those results falling outside of tolerances are coded red, and if warning values are entered, those outside the warning limit but inside the tolerance are coded yellow.

Entering or leaving the values of zero will deactivate the Tolerance function. All readings will then be assigned OK status.

When the Advanced Statistics Option has been purchased the X-Bar/R Chart uses these settings to plot the "high" and “low” test results as red points on the graph; “acceptable” test results are plotted as green points. The operator may also set a high/low warning value - those test results are indicated by a gray color on the Advanced statistics output. The “Warning” test results do not affect statistical calculations.

When the "Acknowledgment Required" box is checked the operator will have to acknowledge every time an out-of-tolerance result is produced, by selecting an "OK" prompt. Also see Section 4.2.1 for information about prompting comments for out of tolerance results.

The "Audible Alarm" checkbox creates an audible signal for the operator to hear when the result is out of tolerance.

After setting the tolerance values, select OK to proceed.
7) Next the operator is given a chance to establish the load. It is important to select the same load as is being applied by the hardness tester. Otherwise the final measured test result will be incorrect.

To change the default values, click on the arrows with your mouse. A selection of all the possible values will appear. For each scale the operator has selected the possible selections for the load and objective will change.

8) Finally the operator has the opportunity to enter a comment. This comment applies to the entire setup file and appears on reports.

This completes the file setup. After the comment screen the operator should proceed with basic testing in the next section before going on the setup traverse routines in the following section.
2.2 Open an Existing File

If opening a recent file the operator can select "file" from the main menu then click the name of one of the last four opened files which appear on the menu selections. Otherwise perform the following:

1) Select Open from the File Menu. The Open File dialog box will appear. If the folder C:\MT92VW does not appear at the top or if the files have been saved elsewhere, select the proper folder.

2) Open the desired file by double-clicking on the file name from the ones appearing or by typing in the file name in the "File Name" box and pressing the "OK" button.

![Open File Dialog Box]

NOTE: If you open a file with another file already open, the current file will be automatically saved and closed.

2.3 Close an Open File

1) Select Close from the File Menu. The file is immediately closed leaving the program still running and on-screen. The operator may then select a new file or exit the program.

NOTE: The operator cannot exit the program by double clicking in the upper left corner of the screen. He must select FILE from the main menu the Exit button
SECTION 3: SINGLE POINT TESTING AND MAIN SCREEN FUNCTIONS

NOTE: The tester must be in single-point test mode to make a single test. Systems open as a default into the traverse mode upon start-up. The operator must select the "Exit Traverse" button near the lower left part of the screen if the traverse prompts are appearing and main menu is grayed out.

3.1 Single Point Testing

The operator can make a test by selecting the "Run Test" button when the test position is seen under the crosshairs on the screen. Once the button is pressed, the tester moves the specimen under the indenter, runs a test, automatically provides a hardness result, and returns the tables to the camera position.

If the test specimen is under the indenter, the operator can selection the "Run Local" button and the system will take a test without moving the X/Y tables.

3.2 Test Result and Tolerance Display

After a measurement has been made the scale and test result appears at the upper left part of the screen. Beneath the result will appear the tolerance limits (if entered in setup file) and after the Accept button pressed a converted test result (if entered in setup file). Color coded indications - green, yellow, and red - appear when tolerances are entered and the results fall within tolerances, within a warning value, or outside the tolerances, respectively.

3.2.1 Prompt the Comments Screen for Out-of-Tolerance Results

In order to be prompted to enter a comment for out-of-tolerance results, the setup must be done when creating a new file. During the file setup select the Prompted Checkbox from the Part Information Field Names and the Acknowledgment Required Box from the Set Tolerances screen. When an out-of-tolerance result is obtained, the operator will be prompted to enter a comment in the Part Information Screen. The comment entered into the top cell of the "Part Information" screen will appear in the report next to that result.
3.3 Clear Last Button

This selection acts the same as the Data Menu selection for clear last. It removes the last test result from memory. Its works only in single point test mode - not for removing a result in a traverse.

3.4 Reports Button

This function is the same as the View menu selection from the top menu. It will display the currently selected reports. For more details see Section 4.

3.5 Status Bar

The status bar at the bottom of the screen shows the systems status (Ready) the file name, scale, sequence number, and the unit of measure for motorized table travel.

3.6 Test Parameters

Display the currently selected load and magnification as well as “TESTER”, the default value for the MT90 version of the C.A.M.S. software. Parameters may be changed using the Update button.

3.7 Update Test Parameters

3.7.1 Update: Changing the Load

The Update option allows the operator to change the selected test load that the MT90 uses to determine the hardness value: the load and magnification. This does not normally need to be changed unless a dual load system has been purchased.

To change the load the operator selects the arrow button at the right of the load display and the drop down box is displayed. The operator can select a new load and select OK to exit out of the Update procedures.

3.7.2 Update: Color, Width

By selecting "Color" or "Width" the operator can adjust the X and Y axis lines in the display for the best width and color.
3.7.3 Update: Changing the Table Offset

This function controls the relative positioning of the camera/monitor to the indenter.

If the cross hairs do not match the center of the penetration after a test has been performed, the operator can perform an adjustment of the camera to indenter position offset. Perform a test. After the table returns back, move the table so the indentation is exactly under the cross hairs and select the **Table Offset** button from the **Update** screen and enter the password at the prompt. Select "YES" to the "Subtract Table Position" prompt. The coordinates will now align perfectly with the indenter. Recheck to verify alignment.

3.7.4 Update: Calibrate button

This function controls the relation of the monitor picture to table motion as controlled by the magnification of the camera. First move the zoom lens to full magnification (the normal viewing position). Select Update and then the Calibrate button. The operator will be prompted to enter a password. Then a prompt will appear requesting the operator verify the position of an indentation or other identifiable mark under the camera position.

Select OK to the prompt and motors will move the point will move to the top right quadrant.

After the point moves to the top right quadrant click on the point then the OK to the prompt. The mark will move under the cross hair.

3.7.5 Update: Changing the unit of measurement

The system can be setup to move and display in increments of microns or thousandths of an inch.
3.7.6 Update: Camera

3.7.6.1 NTSC Camera

If an optional NTSC color camera is used, selecting this box enables the monitor to display the video in color.

3.7.6.2 USB Camera

Enables operators to adjust video image properties, brightness, contrast, etc. There are several selections on cameras using the USB camera. The AGC selection automatically adjusts brightness and contrast. The Manual Gain selection allows the operator to adjust the gain manually if the automatic adjustments are not adequate.

The "Adj. Camera" button allows the operator to make changes to the image in several ways. If these settings are changed, the operator can re-establish the default settings by selecting the RESTORE button.

3.8 Image Magnification and Screen Capture (Save)

The "Save" function allows the operator to capture the camera image. The captured image consists of the live image without the program controls and buttons appearing. While in single point test mode, select the Save button. A window will appear to prompt the operator to enter a file name and optionally of full path statement. A screen capture of the camera image will be saved in bitmap format. The file name extension, ".bmp", is added automatically if the operator does not enter it. It is saved to the current directory or to a different directory if the operator types in a full path name. This image can be printed using most graphics programs.

The Image Size buttons, 1X and 2X, allow the operator to view the image as if magnified at 2X or at standard 1X view. The Image Capture does not work at 2X.

3.9 Full Button

By selecting the full button the operator is able to view more of the surface area of the test specimen. The same controls are still available for moving the X/Y tables and taking tests, but they are located in a horizontal bar at the top and bottom of the screen.
3.10 Basic Motorized X/Y Table Operations

There are three means of moving the motorized X/Y tables: Using the arrows, right clicking on the screen and using the electronic joystick.

**The first way to move the table:** If the operator clicks on one of the table motion arrows (See above and at left), the table will move in that direction by the amount indicated in the increment box. Underneath the table motion arrows is a display of the coordinate location of the table compared to the home position. There are two numbers. The first shows the X or side-to-side location and the second shows the Y or front-to-back location.

The home position is the base or (0.00, 0.00) position. The home position is not an absolute location of the table. Any position of the table can become the home position if the Zero Button (See at left) is pressed. The purpose of the home position is to locate the beginning position for a traverse, and it is a reference position to orient the operator in setting up the traverse.

At any time the operator can move back to the home position by selecting the Home Button. The table will immediately move to the Home position when it is pressed.

Beneath the coordinate location of the table display is the display of the increment of motion. If this number is set for .010 then the table moves an increment of 10 thousandths or 10 millimeters (depending on the setup menu selection for metric or inches) every time an arrow button is selected. The motion as seen on the screen, when the arrows are selected, appears to move the view in the direction of the arrow. If an arrow that is pointing between vertical and horizontal is selected then the table moves ten microns in both axes.

The increment of motion is in either millimeters or thousandths of an inch. The selection of metric or inches is seen in the status bar at the bottom of the screen at the right side. The setting of metric or standard measure can be changed in the top menu bar under Setup Menu selection and then select Test Setup.

**The second way to move the table:** If the magnification is set for full, the operator can move the cursor to a point on the screen displaying the camera image and click with the right mouse button. The X/Y tables will move so that the point that was clicked on is located under the center point of the screen, at the position of the crosshairs. The magnification of the lens and the setting in the software (See under the Update button) must be the same or the motion will be incorrect.

If the operator is viewing the impression with the zoom at low power, the operator should use the Shift key when the mouse key is clicked. The motorized tables will adjust and the table will move the proper amount for the clicked-on point to move to the crosshairs. If the operator clicks on the display when the higher power magnification is being used, the X/Y tables will move the image of the center of the screen.

**The third way to move the tables:** The Joystick on top of the Motor Controller Box can be used to position the table, and thus the part, under the zoom microscope. The + and – buttons adjust the table speed when the joystick is used.
3.11 Traverse Button

Changes the system into Traverse Mode. See Traverse Operations, Section 5, of this manual for more information.

3.12 Space Bar (on keyboard)

During some X/Y table operations the space bar will stop the tester and tables. The operator will be prompted to return the table to the home position. This can be useful if the operator sees that the indenter is going to test on one of the clips of the specimen mount, run off the specimen or perform some other undesirable function.

3.13 Indenter Height Adjustment

The height of the diamond off the part in the vise is preset to about ½ mm (0.020”). The height of the diamond can be adjusted easily from within the software as follows:

1) Exit Traverse Mode.
2) Enter FULL Mode (button on left control panel).
3) Set increment to 0.1 mm and click the up or down arrow at the bottom.
4) When the diamond is at the desired height, click the ZERO button.
SECTION 4  MAIN MENU BAR FUNCTIONS

4.1 Main Menu Bar: View

4.1.1 Reports (Advanced Statistics Software)

The View Menu consists of 7 different functions: X Bar/R Chart, Histogram, History Data, Tile, Auto Tile, Tool Bar and Status Bar. When activated, a check mark will appear in front of the function listing.

Click on View to display the available functions. Click on the individual functions to activate.

- Reports - Shows the data in the current file, as well as a histogram and X-Bar/R Chart of the data.
- Tile - Resizes and rearranges all open windows so that they fill the screen.
- Auto Tile - Opens all windows, and automatically resizes and rearranges them so that they are restored to the original arrangement.
- The Tool Bar & Status Bar can be turned on and off by clicking on them.
- The Image Selection returns the system to the main testing screen.
4.2 Setup Menu

The Setup Menu consists of six different functions: Average, Test Setup, Tolerances, Scale Select, Communication Setup, and Settings.

4.2.1 Average Menu [Appears when averaging option is enabled]

The operator may select to record averages of multiple tests rather than the individual tests. The data file must be empty to perform or change a Average Mode selections. If there are tests already in the file, the Set Average Group Size button will not appear activated.

To operate the averaging function open a new file or clear all data out of an existing file. Select the first option from the Setup menu: Average. Enter a value in the average group size box.

After the group size value is entered, some or all of the options will be enabled. To disable the functions enter a "0" value. The averaging functions are as follows.

Keep All - The default setting. Calculates an average in the normal manner.

Eliminate Highest and Lowest Values
When 3 or more tests are selected to be averaged the system will remove the highest and lowest values from the group average. For example, if the average is set for 5, then 3 results will be averaged. If an average of 2 is selected the function is disabled (see above).

Eliminate furthest from the average
Once the testing is completed the system calculates the average and removes the one test that is furthest from that average. If an average of 2 is selected both values are kept.

Eliminate the furthest from maximum standard deviation - The operator is prompted to enter a maximum standard deviation value. When the testing is done the value furthest from the standard deviation allowable is removed. If all the values fall within the standard deviation then none are removed.

When averaging is running, after every set of results the report menu will appear showing the averaged value and intermediate values in the top window. The X-Bar & R Chart will show a position for the averaged value and a line extending through the average value indicating the range of the results. Note: If one of the results is selected in the X-Bar & R chart it will have a line extending through it from the top to bottom of the screen, and in the data the selected result will be highlighted.

Select the Image button to return to test mode.
4.2.2 Test Setup

The Test Setup is used to enter file parameters that apply to reports and data storage.

The Company Name box allows for up to three rows of data to be input. This name will appear at the top of all the report. The Top Margin box allows the operator to control how many blank lines are entered at the top of the form. The Work Order/ File Comment box which also appears at the top of the printed report.

The Traverse Results option enables the operator to set a default for saving traverses. If the operator selects Save Optional, a window will appear prompting the operator to save or not save after the traverse. Otherwise the results are either automatically saved or not depending on the selection.

The Network Drive option allows the operator to automatically copy the current datafile to an additional location. The data copy function occurs every time the file is closed.

The Traverse Mapping selection allows an operator to create an outline of a test sample in order to improve navigation when selecting multiple traverse locations. Enabling the mapping here, makes the mapping routine prompts appear during the traverse test sequence.

4.2.3 Tolerances

The tolerance selection is for changing tolerances in an existing file. Its operation is exactly the same as the initial file setup. (Refer to the File Open section.)

NOTE: Entering zero values for both will deactivate the Tolerance function. All readings will then be assigned an "OK" status. Also, once a file has been set up with tolerance settings, changing the tolerances will affect the statistical calculations for all the test results that have been entered to that point.

The Audible Out-of-Tolerance Alarm beeps the operator when a result is obtained that it out of tolerance. When the Acknowledgment Required box is checked the operator will have to acknowledge every time an out-of-tolerance result is produced.
4.2.4 Scale Setup

This is used to select new Primary and/or Converted Scale designations. The function is exactly the same as has been described earlier under the File Open.

The scale can only be changed while setting up a new file. Once data has begun being collected, you cannot change the scale for the current open file. If you try to do so, a dialog box will appear prompting you to close the current file. To change the scale clear all data from file (See data menu.)

4.2.5 Communications Setup

Communications Setup is used to set the parameters of the Serial output for communications with a serial printer or to another computer. At the end of each test (when the result is accepted), the information can be sent through the serial port. The data string selections are Parity, Data Bits, Data Rate (Baud) and Port.

Check boxes are provided for the type of output; if the entire string of the history data is to be sent to the serial port (the same string as it appears in the data line) then select "Output All"; if the "Output Result Only" box is checked, only the actual value accepted is transmitted. If "Output Off" is selected then no data is sent. If the Enable Trace box is checked, the data seen at the lower left part of the toolbar in the main window (File name, Scale, Test number) is added to the test result in the serial output.

4.2.6 Settings

The settings selection allows the operator to set the same load in the computer as is being used by the tester.
4.3 Main Menu Bar: Data

The Data Menu consists of 4 different functions: Clear Last Test, Clear Test #, Clear All Tests, Statistics, and Part Information.

4.3.1 Clear Last Test

This function is used to clear the last test result from memory. It is the way in which you can delete an erroneous reading caused by machine or operator error and not affect the statistical calculations. This is the same as the UNDO-button.

1) Select Clear Last Test from the Data Menu. A dialog box will appear asking you if you are sure that you want to clear the last test taken.

2) Select the Yes button to delete the last test.

4.3.2 Clear Test Number

This function is used to clear any of the test results in the current file from memory.

Select Clear Test # from the Data Menu. A dialog box will appear asking the operator to enter the test number. Enter the number to be deleted. After the number is entered the operator is prompted to verify that it is the proper number.

4.3.3 Clear All Tests

This function is used to clear all of the test results in the current file from memory.

Select Clear All Tests from the Data Menu. A dialog box will appear asking you if you are sure that you want to clear all tests in the current file. Select the Yes button to delete all tests.
4.3.4 Statistics

This function provides an on-screen listing of statistics. The operator can select a range of results (at bottom of screen) and the statistics will automatically change to reflect the selected range. "No Cpk" will eliminate this value from the reported information. Any selected range of data can be exported to a comma-delimited .csv file. If Averaging has been implemented under the setup menu, the averaged values and the values comprising the average (up to 5) appear under Position 1, 2, etc.

![Image of Statistics Function]

4.3.5 Part Information

This function is used to enter part information in each file that will appear on the reports (almost the same as appears in creating a new file). Select Part Information from the Data Menu. A dialog box will appear where the operator can enter descriptive information. This function pertains only to single point testing - not traverses. Selecting "Sort by Prompt" will sort data in the printouts by the prompts so commented data can be readily identified.

Differing from the Data File Part Information found in creating a new file, the checkbox for "Prompted" and the "Field Names" button are grayed out so the operator cannot access them.

![Image of Part Information Function]
SECTION 5: TRAVERSE OPERATIONS

By pressing the Traverse Button on the single point test mode screen the operator is able to access Traverse procedures. These functions (at left) provide many options for creating, editing and running traverse test procedures and obtaining reports and providing for documentation and descriptive information.

5.1 Create Traverse

By pressing the Create button operators can start the process of creating traverse specifications with specific test locations and descriptive information. This is often done to facilitate testing a single type of part or group of parts while keeping the data in its own database. It is best to have a test specimen in place prior to traverse setup so the operator can view the specimen while positioning test points.

Create a name

The first step in creating a traverse specification is providing the name of the test sequence and optionally a comment. This screen also allows the operator to select the format of the network data storage.

If the arrow at the right side of the Result File Format field is pulled down, three options appear: None, Block Record, and Row Record. If “None” is selected then there is no network record. If “Block Record” is selected then the data is stored in Column format so that each record has data extending vertically. If “Row Record” is selected then the Data is stored so that each record extends horizontally in a row format. Data is stored in folder C:\MT92WV\MULTUSER.

Another selection in the Create New Traverse window is the selection for Traverse vs. Graphic Mode Traverse. The Traverse is the standard mode. If the Graphic Mode option has been purchased please refer to the Appendices for a description.
Part Information Field Names

This screen allows the operator to setup unique labels for the descriptive data that can be entered during the actual testing, e.g. "PART#" can be changed to "MODEL#". To change the labels enter new labels and press the change defaults button and the operator will be prompted to confirm the entries. If the operator is in the middle of changing the defaults, he can revert back to the previous values with the USE DEFAULTS as long as he has not confirmed the changes.

Traverse Test Description

The operator will have an opportunity to enter a description for traverse #1 of this setup. If multiple traverses are created in one file, then the operator can give each traverse a distinct name, so later the operator who is running the traverse knows which traverse location or type is about to be done.

Move to Origin

The operator must now move the table to align the edge of the part to the origin (the beginning point at the very edge of the test specimen. Use the low magnification and roughly position the specimen. Use the arrow keys or click with the mouse to move the specimen around. The increments of table motion can be changed with the buttons below the arrows. (See Section 3.10)

Move the specimen until the edge is precisely located in the crosshairs. The edge of the specimen does not need to be perpendicular to the travel of the motors. After positioning the origin select OK from the Prompt.
**Traverse Direction**

The operator must now click and drag on the screen to move the arrow so that it points in the direction that the traverse will follow. The actual degrees shown in the prompt box will change as the operator moves the arrow and will freeze at the final angle when the operator hits the enter key or OK.

**Enter Test Points**

The operator must now locate the traverse test points by positioning the cursor in the traverse layout grid and clicking on thee grid which will make a red mark. If one point is not in the correct position, it can be removed by clicking on it a second time. All points can be removed by selecting the "clear All" button.
If the operator needs to make tests at increments different from the default setting of the Traverse Layout Grid he can select the Grid Spacing button prior to setting the points. There are two axes available. For standard straight line traverses adjust the Y axis increment only. (Note: Changing the unit of measure from inches to metric must be done in Single Point Test Mode using the Update button.)

If the operator selects the "Tolerance & Loads" check box, then after every test point is created the operator will be prompted to enter tolerances values for the test results and/or to change the loads and objectives. The box can be checked or unchecked as any specific test point is created to create tolerances and changed loads for specific points. If the system does not have the optional automatic turret, the "Use Obj." and "Use Load" selections will be grayed out.

Creating Staggered Traverses

If the operator needs to position tests closer than the minimum distance allowable (twice the distance of any stress deformation or fractures so that there is no overlap of deformation) for a given load, the operator must stagger the tests so they maintain the appropriate distance but they still step from the surface in the correct increments.

To create a staggered traverse select the Grid spacing and select the values desired for both the Y and X axes. Position the first point closest to the surface and the next should be offset laterally by at least the minimum distance and stepped one increment deeper. This procedure is repeated a number of times. To keep the path of the traverse perpendicular to the surface as much as possible, the sideways offset can be reset to the first test after the minimum distance has been reached.

For example: Below is a Staggered traverse sequence in .001” increments from the surface where the minimum distance between points is .005” and the first test is located at .004” from the edge of the specimen. The next is shifted to the right by .005” and back from the edge by .001” more. The third test is offset the same amount. The next test point is moved to the left by .020” and back by .001” to start a new row then the .005” offsets are repeated. Finally at the end of the traverse is created in a straight line. Note: each test is .001” farther from the Edge position than the last but each is located at .005” from the others.
Traverse Setup: Effective Case Values  (See below)

The operators are next prompted to enter the desired effective case hardness values they are seeking (in Rockwell scale hardness numbers and the maximum and minimum effective depth tolerances (in thousandths of an inch). Up to three case hardness values can be entered for each file - each having its own effective depth tolerances.

Additionally, Surface and Core values can be entered with their related depth tolerances. Finally a Quit value may be entered which will end a traverse sequence if this value is reached. The Surface, Core and Quit values are not used in the effective case depth graphs or case depth calculations, just reported as results.

There are check boxes for User Defined, Nitride Case, Eht Case, Rht Case and Nht Case. User Defined is the Standard and default setting. With the box for Nitride Case checked the system will add 100 Vickers points to the core value and use this sum as the case hardness to calculate the depth. If no core value is generated then the last result is used in its place. The Eht, Rht, and Nht Cases all calculate the case depths per ISO and DIN specifications.

There is also a button labeled "Change Defaults." If the case hardness values in this screen are changed then selecting the Change Defaults button will cause all following traverse setups to automatically use the same defaults (unless it is changed manually.)

Dual Traverse Mode

Setting up a second traverse will enable the operator to perform multiple traverses in the same specification or optionally select only one of the traverses to run. If it is selected the Traverse setup routine repeats.

Save Traverse

After setting up the traverse the operator can select to save or cancel the setup. The system will revert to the Traverse Menu.
5.2 Edit Traverse

To edit a traverse the operator must select the Traverse button from the Main screen and then choose the Edit button. The screen allows the operator to select which setup to choose. After a traverse specification has been selected, the same procedure for editing a traverse specification is used as is used for creating. Please refer to previous section.

The operator must move through the entire procedure until the Save function appears at the end in order to save the edited Specification information. If the operator backs out by selecting Cancel or Escape, the edited data will not be saved.
5.3 Run Traverse

When the operator is in Traverse Mode and selects "Run Traverse" button, he is prompted for the traverse specification to choose. Click on the file name and the "OK" button.

Next the Data Part File Information Screen will appear. This information appears on the printouts and is stored in the data file. Just as in the original file creation the data and the labels can all be changed. The Sort-by-Prompt checkbox enables sorting data in the printouts by the prompts so commented data can be more readily identified.

If there are multiple traverses created in a single setup files, the operator is prompted to select which of them to remove from this particular this traverse sequence.

Next the operator is prompted to locate the “origin” of the motor test sequence, which is also the edge point of the part, from which the traverse will proceed. Select OK.
Next orient the direction of the traverse. In the picture below you can see the test being oriented at 326 degrees which is off to the lower right on the screen. To move the arrow move your mouse over the screen and the arrow will follow. The center of the line that meets the edge of the specimen has a clear area in the middle for improved positioning of the surface. Click the mouse to freeze the arrow position. Then select OK.

If multiple traverses are setup to be performed, the operator will be prompted to find the traverse origin and angle for the remaining traverses; the tester will perform all traverses automatically.

Next the operator is prompted to OK the start of the test procedure as seen at right. At this point the traverse testing commences and all the tests are performed and the motorized tables bring the specimen back to the camera position when complete.

Once the comment screen is OK'd a small view of the Graph of the results is displayed. The operator can Zoom in to see details, see all of the graphs in sequence (in multiple traverse operations) or see both traverses side-by-side (in multiple traverse operations), and print the results. Comments appear in various places on the results and the case depth results are printed at the bottom.

The lines indicating the location of the effective case depth locations are green if the result is at the correct location as defined in the tolerances or in red, if not. If no tolerances are used then the lines are green. Individual results that are out of tolerance are indicated with an asterisk.

See next page for an almost full-size printout of the report.
5.4 Traverse Reports

The Traverse Reports Button provides the same reports as appear after a traverse, and there are options for more advanced reporting. To see the reports select the Traverse then Reports button and select a Traverse Specification.

5.4.1 Standard Reports (See following pages)

If the operator selects Standard Reports after selecting a traverse specification, a screen will present a list of all the traverses taken using that specification in chronological order. Each traverse selection lists the record number, date, time, and comment. After selecting an individual report, select to view a combined or standard “display” report. (See next page to view samples)

5.4.2 Multiple Reports (See following pages)

If the operator selects multiple reports after selecting the basic traverse specification, then he will be allowed to select the specific traverse (if the specification had a combined traverse there may be more than one). Then the operator will be prompted sequentially to include each of the traverse records stored in the file.

There are three types of Multiple Reports: Graph, Chart, and Display. Graph shows all the traverses in the file simultaneously. The Chart a Graph of the Case depths plotting the case depths side-by-side. The Display Report shows the case depths in a tabular format.

Report shows the Case depths in a tabular format.
The Display Report, above, shows the standard report that appears after testing. If multiple traverses are set up under this traverse specification then two pages will be printed out showing each curve.

The Combined Report, left, will display all the curves at the same time in instances where the report specification calls for more than one traverse.
Graph Report

Chart Report

Display Report
5.5 Traverse File Menu (Maintenance)

The operator can select the Traverse "File Menu" button in order to handle maintenance issues such as copying traverse sequence files or deleting them. The screen shows a list of traverse files and their descriptions.

By Selecting a traverse specification file name the operator can select to delete the file setup (Setup and Run, delete all the data (Run Only), or delete the last record in the file (Run Only).

![Traverse File Maintenance](image)

The operator can also copy the file setup sequence to another name to replicate the setup details and change the comment for this file. The Copy button must be selected after a new name is provided for the file.

The Edit User Fields button allows the operator to go into the File Part information Entries and edit the content that was entered during the testing process.

Select Close to exit.
SECTION 6: MACHINE CALIBRATION CHECKING

- Check the accuracy and repeatability of the tester using microhardness test blocks, NIST-traceable Rockwell C scale test blocks or Newage/Yamamoto TNY Rockwell C scale test blocks. Take 5 readings in each quadrant of the test block.

- The allowable range of repeatability from those readings should be within HRC 1.7 pts. at HRC 60, (or equivalent microhardness values) and within HRC 3.0 at HRC 30 (or equivalent microhardness values) (Based on an equivalence to the specification for HV1000 in ASTM E-384.)

- The allowable range of accuracy for the machine is based on the average of five tests in each area. They should be within 1.1 pts. of the test block value at HRC 60 and within 2.25 pts. at HRC 30.

- Refer to Calibration and Zero Set Key for instructions if the tester needs adjustment.

CALIBRATION

The file C:\Mt92vw\MT91.dat contains the values used for calibration. Typically it contains three lines, as follows:

30.97 16.502
45.8 12.56981
62.03 7.864

Where 30.97, 45.8 and 62.03 are the 3 test blocks used and 16.502, 12.56981 and 7.864 are the average depths (microns) of the tests on the test blocks. Removing the file mt91.dat (or its entries) will cause the tester to operate in uncalibrated mode and cause the depths to be reported. At this point MT91.dat is created and/or edited by hand. Up to 18 test block values and associated depths can be used, but HRC 30, 45 and 60 blocks should be enough. These values can be easily acquired by creating a "Test Blocks" traverse (check box in first dialog when creating new traverse), which will run multiple tests on multiple blocks, prompt for their hardness value and tabulate the results.
SECTION 7: TROUBLESHOOTING GUIDE

VARIETY OF PROBLEMS

- Check to make certain the screen saver is turned off.

NO (OR POOR CLARITY) PICTURE

- Make certain that all video system components are plugged in, turned on, and properly connected with one another.

- Make certain that the contrast settings (update button) and are set properly.

- Check the position of the specimen to make certain that the mounting clips have not loosened, making the specimen seat at an angle or at a higher position.

- Check the focus of the camera lens. This should be set while set at the maximum power setting to ensure that the lens is in focus for the entire travel of the zoom.

- Make certain that the test head is adjusted to a height of .030 -.060” above the specimen.

CROSSHAIR & CAMERA/INDENTER OFFSET POSITIONING PROBLEMS

- Perform the camera/indenter offset routine in the Manual Test Mode.

- If the offset changes in one or both axes, make certain the focus adjustment on the lens is securely tight. If it is not, the test head shroud may have to be removed and the lens tightened.

- Make certain that the table, specimen mount, specimen, and indenter are all tight.

- Make certain the motors are securely tightened onto the shafts of the lead screws on the tables. Apply light pressure to the table by hand and move the table using the arrow keys. If this easily magnifies the error, tighten the motor/table clamps after removing the console shroud.

- Test the table bearings by spinning the ends of the lead screws (after removing the console shroud.) There should be no slack between the rotation of the lead screw and the movement of the table.

- Make certain there is nothing jamming the motion of the table while it travels; especially from camera to indenter position.

- If there is a grinding sound, apply lead screw oil to the lead screws. Move the tables back and forth and then re-check for positioning problems. If they persist, contact the factory.

- If all the aforementioned procedures have been followed, run the X/Y table back and forth in each axis, by varying distances, to see if there is an offset. Start the movement from a clearly defined position such as that of a test penetration. Also, run the manual test procedure a number of times to determine the size and direction of the offset.
PROGRAM WILL NOT PROCEED

- Make certain a valid key is being used.

- Try re-entering the key repeatedly. If a persistent problem exists, contact the factory.

- Check to see if the [CURSOR LOCK] and/or the [CAPS LOCK] are on. If so, unlock.

- Use the ESC escape key to back the program up to the desired place.

- Reboot the system, and check the position of the motorized tables to verify that they have not overtraveled the limit switches.

- Make certain power is turned on to the motorized tables.

- Check all fuses and connections on each of the different components.

INACCURATE OR NON-REPEATABLE TEST RESULTS

- Check the test results on a Yamamoto quality test block at various areas of the block. If the results are not acceptable, check the following:

- Make certain the specimen, mount, tables and test head are all tightened.

- Check the height of the specimen from the indenter. This should be between .030 and .060". If it is much higher, it can read high. If set too close to the specimen surface the indenter can have an impact effect and the results will lose repeatability.

- Check that the indenter area and shroud are clean. Any residue on the specimen in the area of the indenter or on the indenter itself, must be removed.

- Make certain the specimen mount is holding the specimen in a level position. Be sure that each clip screw is positioned at an equal height.

- Check to see if the test head is perpendicular to the test surface. (This may be checked by wetting the top of the shroud, making a test and looking at the mark on the specimen. If it does not evenly surround the penetration, adjust the orientation of the test head.)
SECTION 8: MAINTENANCE, SERVICE & REPAIRS

8.1 Maintenance

Clean the indenter area with a brush or lint-free rag and residue-free, non-water base cleaner to remove gums, oils, and particulate matter buildup.

(NO OTHER MAINTENANCE PROCEDURES ARE REQUIRED OR RECOMMENDED)

8.2 Service

Call our Technical Customer Service Team to make arrangements for service.

8.3 Moving the Tester

Follow the directions for packing of the computer and parking the disk found in the PC manual before moving the computer.

The Test Head should be kept in an upright position and shocks should be avoided. If the Test Head is removed for shipment, the shipping screw should be installed immediately after lifting the test head up from the base. (See the diagram below.) Do this before laying the test head over on its side. Two people may be required.

The other components should be disconnected and handled with normal care.
8.4 PACKING THE UNIT FOR SHIPMENT

If the Newage Service Department has been called to confirm the test head needs to be returned:

TEST HEAD SERVICE ONLY

1) Remove the test head by unscrewing the head locking collar (bottom section) and lifting the head straight up, taking care not to allow the indenter area to touch against anything.

2) Continue to hold the test head upright and reattach the head locking collar, press the indenter protector into place (carefully without contacting the indenter tip), then screw in the shipping screw finger tight plus a turn with a screw driver.

3) Place a tube over the indenter area and tape into place.

4) Wrap the test head in bubble pack with at least two inches thickness of bubble pack or equivalent.

CAUTION: Packing peanuts and other loose fill which allows shifting of the contents IS NOT EQUIVALENT TO BUBBLE PACK. The test head is both heavy AND delicate, so great care must be taken to provide adequate padding.

5) Remove the entire electronics box with the keypad by unscrewing the connectors and disconnecting the power cable. Wrap the electronics equivalent to the test head.

6) Fill the bottom of a sturdy double-wall corrugated box (or wood or similar) with packing material and place both the electronics and the test head in a sturdy double-wall corrugated box or similar with more packing between them, around them and over top.

7) Mark the box as delicate and insure for the value of the components.

8) Include a contact name, phone number, and brief description of the problem.

9) Ship to Newage address on back page

Indenter-area protection for shipping (view as seen from back of tester looking up at the bottom of the head).
APPENDIX A1: SPECIFICATIONS

INSTALLATION SPECIFICATIONS

Power Supply: Clean 110V, 60HZ, 6A, single 3-prong outlet.

Minimum table area required: 36” x 24”

PERFORMANCE SPECIFICATIONS

Test cycle speed: 7 seconds for single test cycle with test specimen located under indenter; 20 seconds approximately including the table travel from camera to indenter and back.

Accuracy & Repeatability: Within those prescribed by ASTM E18 for Rockwell Hardness Testing Systems (using test blocks calibrated for micro loads.)

Method of testing: Depth measurement similar to ASTM E18 but with non-standard loads and indenter. Readout values given correspond to Rockwell C values and are designated as HRC.
APPENDIX W: ONE YEAR LIMITED WARRANTY

Should Newage Testing Instruments, Inc. equipment require service, we will repair or replace, at our option, any part or product which upon examination by a Newage service technician, shows to be defective in material or workmanship. This warranty is extended to the original purchaser only, for a period of one year (12 months) from owners date of purchase. Excluded from this warranty are any parts that are to be replaced as part of normal product operation, such as indenters.

This warranty IS NOT VALID IF THE INSTRUMENT HAS BEEN MODIFIED, MISUSED OR DAMAGED in any way. This includes damage caused by disassembly by any person other than an authorized Newage service technician.

Please read all operating instructions supplied with the instrument prior to operation.

Newage Testing Instruments, Inc. is not responsible in any way for losses, damage, or other form of consequential damage resulting from equipment failure or improper use.